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Good Morning! 
Day 1 

Technology Integration 
 
 
 

 
 
 
 
 
 
 
 
“Taken together the tools of technology offer flexibility and 
individualization to help reach an increasingly diverse student population 
provide experiences that engage their interest, and respond to a range of 
needs. To be successful, the use of these tools must take into 
consideration children’s needs to be active and involved, learning with both 
their bodies and their minds.” 

“Learners, Language and Technology: Making Connections that Support Literacy” 
Northwest Educational Technology Consortium 

http://www.netc.org/earlyconnections/pub/index.html 
 

http://www.netc.org/earlyconnections/pub/index.html�


Ready for Reading, Technology Tools in the Early Elementary Classroom                                                       Day 1 
 

Copyright © 2004-2009 i3 Training Services Inc.          inspiring,  innovative,  instruction      P a g e  | 2 

 

 



Ready for Reading, Technology Tools in the Early Elementary Classroom                                                       Day 1 
 

Copyright © 2004-2009 i3 Training Services Inc.          inspiring,  innovative,  instruction      P a g e  | 3 

The Research 
 
There is a growing body of research that supports the use of technology with young 
children. The National Association of Educators of Young Children (NAEYC) as early as 
1996 wrote a position statement in which they detailed seven points about technology 
usage. The points they addressed are: 

1. the essential role of the teachers in evaluating appropriate uses of technology 
2. the potential benefits of the appropriate uses of technology in early childhood 

programs 
3. the integration of the technology into the typical learning environment 
4. equitable access to technology, including children with special needs 
5. stereotyping and violence in software 
6. the role of teachers and parents as advocates 
7. the implications of technology for professional development. 

Technology and Young Children- Ages Three through Eight NAEYC 1996 
 

For each point, NAEYC describes a role and guidelines for how and in what ways 
technology should be used.  There has been a lot of research since that time and a lot of 
new technology developments. Douglas Clements in “First Experiences in Science, Math, 
and Technology” writes, “Research has moved beyond the simple question of whether 
computers can help young children learn. They can. What we need to understand is how 
best to aid learning, what types of learning we should facilitate, and how to serve the 
needs of diverse populations. In some innovative projects, computers are more than 
tools for bringing efficiency to traditional approaches. Instead they open new and 
unforeseen avenues for learning.” 

“First Experiences in Science, Mathematics and Technology” from Dialogue on Early Childhood Science, 
Mathematics and Technology Education 

 
Our Beliefs 
This training has been researched, designed and implemented based on points that 
NAEYC raises as well as various research findings. However, this training has no legal or 
other informal relationships with these entities.  i3 Training Services  firmly believes 
that technology usage should be developmentally appropriate and should be integrated 
into a well-designed program which addresses the needs of the whole child. Technology 
will not replace excellent teaching and hands on learning. However, technology can 
enhance, engage  and support children’s learning and provide experiences not readily 
available in students environment. 
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How will my teaching change if I use technology? 
Learning something new requires change. Some of the changes that people have 
experienced as they began to use technology with students are: 

• a shift from technology as a reward or play thing to the deliberate use of 
technology with students 

• a shift from a limited or episodic use of technology to the inclusion of technology 
into planning for everyday instruction 

• the development of a vision of the role that technology can play in the learning of 
young children 

• the development of a new role as a guide rather than sole purveyor or information 
in a classroom 

 
Will this happen overnight? 
No, change takes time. In this training you will be exposed to new ideas and new 
technologies. Will all of them be right for you and your students immediately? No, begin 
using your new knowledge slowly developing a comfort level with different portions of it. 
Over time you will find that what once was unthinkable is now happening. We are also 
cognizant that many pre-k classrooms are not equipped with the latest and greatest 
technology hardware and software. Frankly, that might be a good thing up until now. We 
are firm believers that we should have an understanding of how the tools  should be 
used before we spend thousands of dollars purchasing tools that might not get used. 
This training will provide you with a solid foundation in which to build and make decisions 
about equipment and resource acquisition.  
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Statement of Beliefs 
 

I Believe….  
 
• That great curriculum + effective methods = better student achievement 

 
•  It doesn’t matter how much technology you have, it’s what you do with it that counts 

 
• In asking what strengths a student has first before discovering the deficits 
 
• That instruction should be a blend of whole group, small group and individualized 

 
• Coaching is more powerful than lecturing 

 
• That all students can be reached with the right tools 

 
• That assessment should be frequent, individualized and relevant 

 
• That competition can only get you so far, but the rewards of cooperation are 

limitless 
 

• Shifting from the primacy of verbal thinking to the integration of visual, verbal and 
kinesthetic learning provides greater access to learning. 

 
• Technology is a tool not a curriculum. 

 
• Technology as a tool should Enhance for greater Engagement, Encourage support and 

collaboration and Expand access and depth of knowledge.  
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Reading Fun 
 

Get up and chat with your colleagues and find out a little more about them. Ask if they 
have done any of these things and then have them initial in any box. Be sure to get them 
to tell you about it. 
 

 
 
Has been to 

hear a 
children’s 

author speak. 
 
 

 
 

Only reads 
during the 
summer. 

 
 

Finishes a 
book even if 
she doesn’t 

like it. 

 
 
Chooses books 
by the cover. 

 
Has a 

personal 
collection of 
children’s 
books. 

 

 
Has stuffed 
animals that 

are book 
characters. 

 
Has a public 
library card 
and uses it. 

 
Stays up late 

at night 
reading if the 
book is really 

good. 

 
Checks the 
bestsellers 
list to see 

what is hot. 
 
 

 
Prefers 

reading the 
book to seeing 

the movie. 

 
Can name 

three books 
by a favorite 

author. 

 
Participates 
 in a book 

club. 
 

 
Can stay for 
hours in the 

local 
bookstore. 

 
 

 
Has a favorite 
all time book 
that she re-

reads. 

 
Is willing to 
name her 
guilty book 
pleasure. 

 
Receives a 
newsletter 

with 
information on 

children’s 
books. 
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Where the Wild Things Are 
 

Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional tool in 
my classroom? How can a data projector facilitate 
instruction? How do I use Kidspiration software? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole Group 
Instruction  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
PowerPoint and 
Data Projector 
 
 
 
 
 
 
 
 

Essential Question for the Lesson: 
Can students identify key components of a story including the 
characters, setting, main event, and ending? Can students put 
the sequence of events in order? 
 
Learning Goals: 

• Students will listen and participate in the activity. 
• Students will respond to questions. 
• Students will contribute to the conversation. 
• Students will recall events in the story. 

 
Materials: 
A copy of “Where the Wild Things Are” by Maurice Sendak. 
 
Technology Connections: 
Students will work with the teacher to complete an activity 
using Kidspiration and work independently using Kid Pix to 
create their own wild thing. 
 
Procedures: 

1. Organize the students so they all can see the 
computer. Introduce the activity by telling the 
students that you have a book to read to them and will 
be using the computer to talk about the story when we 
are done. 

2. Use the PowerPoint to preview some of the new 
vocabulary in the story. Discuss the meaning of the 
words and have the students when appropriate act the 
words out. Tell the students that when they hear some 
of those words in the story you want them to give you a 
thumbs up to show they are listening carefully. 
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Kidpsiration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Read “Where the Wild Things Are” slowly taking time 
to look at the pictures and discuss what is happening. 
Pause when you read a vocabulary word you introduced 
to see if the kids give you thumbs up. 

4. Break at this point before beginning the computer 
activity. When you begin again, show the pictures of 
the story and have the students tell you what is 
happening in the story. 

5. Open Kidspiration and create a box labeled Title and 
three boxes attached to it:  characters, setting, and 
main events. Tell the students that all stories have 
some things in common.  They are going to learn about 
them by telling you about the story they just read. 

6. Click in the Title box and ask the students to tell you 
the title of the story. Type it into the title box. 

7. Ask the students who was in the story? They will tell 
you Max and the wild things. Click on the character 
box, read the word “Characters” to the students and 
tell them that every story has characters in it. Fill in 
Max and the wild things. You may want to take time to 
have the students give the beginning sounds of the 
words. 

8. Next ask students where did the story take place? 
They should tell you Max’s home or room and the land 
where the wild things live. Click on setting and read the 
word “setting.” Tell the students that every story 
takes place somewhere.  

9. Finally, ask students what happened in the story. Click 
on the term “Main Events” and read it. Add 2-3 boxes 
off the main event and write brief summaries using 
simple words of the student’s descriptions on the story. 

10. Before leaving this template, go back and ask student’s 
questions like “Which word describing Max begins with 
a ___?”  

11. A second way to review this is to see if the students 
are able to apply those words to another story you have 
read recently. 

12. Again, determine if your students need a break or are 
ready to proceed to the next activity. If they are 
ready, go back to the Kidspiration template and ask 
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Kid Pix 

them to describe Max. Add 2-3 boxes to Max’s name 
that describe him. Do the same for the Wild Things. 
Use the book with this activity so that the students 
can refresh their memory. 

13. Explain that how a character looks and acts and thinks 
makes a big difference in a story.  Tell them that they 
are going to draw themselves and a wild thing using Kid 
Pix.. 

14. Open a web browser window and go to 
www.buildyourwildself.com web site have students use 
the web tool to create a before and after wild self 
portrait.   

15. Students will save their images to the desktop project 
folder and label it with their name.  

16. Open the program and go into Kid Pix.  
Introduce the line tool, the eraser and the paint 
bucket. Have the students draw a picture of a wild 
thing they would like in their story. If appropriate, 
have the students type their name on the picture using 
the typewriter tool and print them out.  

17. To complete this activity, meet with each child 
individually and ask him/her to tell you a sentence 
describing their wild thing. Write the sentence on the 
back of the picture for the child or allow the child to 
write the sentence using invented spelling.  Ask the 
students if their wild thing is the same or different 
from the ones in the story we read. 

18. If teachers choose to, they can go back and bring the 
PowerPoint up to review the vocabulary one more time 
having the students explain the meaning of the words 
this time. 

 

http://www.buildyourwildself.com/�
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Software Helper  
Kidspiration 

 
 

 
 
 
 
 
 
 
 
 
 
Beginning the Program 

• To start a new document under the New category click on either Picture or 
Writing. In picture mode you are creating a diagram. The writing mode is an 
outline. Users can go back and forth between picture and writing mode with a 
click of an icon. 

• Click on Open to locate a file that is in progress. 
• Click on the subjects below Activities to open pre-made Kidspiration templates 

with students. When a template opens it is untitled and needs to be saved under a 
different name. This preserves the original template and allows teachers to make 
as many versions of it as needed. 

 
To Work in a Picture 

• When a picture is opened a circle with the words “First Idea” in a text box is in 
the middle of the screen and highlighted. Type the main topic of the brainstorm 
in that space. It is already highlighted so just begin typing. Users do not need to 
erase the words that are there. 

To Add Symbols   
• Off the Main Box click on the Add Symbol Button. A new circle will be added. 

 
• Click in the middle of the circle twice to begin typing. 
• Click back on the main topic first before adding additional symbols. 

To Change the Symbol to a Picture 
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• Click on the symbol to select it. 
• On the left hand side of the screen in the blue bar is a picture library. Click on 

one of the pictures to change the circle to the picture 
• The down arrow towards the top of the picture library shows a list of categories 

of symbols. The left and right arrows allow users to scroll through the picture 
categories. 

• When a picture replaces a symbol box the text goes below the picture. 
To Re-size All Text 

• Click in the white space so the curser is not in a box 
• Under the Edit menu click on Select All 
• Use the Font and Text options on the bottom left of the screen to make changes. 

To Change the Text in One Box 
• Click in a box 
• Under the Edit menu click on Select All. 
• Use the Font and Text options on the bottom left of the screen to make changes. 

 
To Move a Box 

• Click on the box so that the four red handles appear. 
• Click in the middle of the box, hold the mouse button down and drag the box to a 

different location. Release the mouse button once the box is moved. 
To Insert a Blank Symbol Separate from the Diagram 

• Click in the white space so that the curser becomes a crosshair. 
• From the Picture Library click on a symbol  

To Connect an Unconnected Symbol 
• Symbols are connected with arrows that imply a direction. Determine which box 

you want to connect where. 
• Click on the box and the box and then on the Link Symbols icon on the top of the 

screen.    

  
• The curser becomes a line. Next click on the symbol to be connected. A new arrow 

will now connected you starting box to the loose symbol. 
 
To Change the Diagram to an Outline 

• Click on the Go to Writing symbol at the top of the screen. 

  
• The Move Left or Move Right arrows allow users to change indentation of the 

symbols. 
• Click next to the text in the boxes to add more information 
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• Click on Go to Picture to go back to the diagram mode. 

  
To Put a Name on a Document 

• Click on the Student Name symbol and a Student Name box will open. Select 
where on the page you want the name to appear and type the name in that box. 
Teachers can also type a title instead of a name. 

  
• Notice the option to print page numbers. If you have a large picture, page 

numbers might be useful. 
• Click OK to close the box. 

 
Special Features 
 
To Change the Line Colors 

• Click on a link so that it has handle bars. 
• On the bottom menu bar there is a little bar of color. Click on it and a palette of 

fill colors opens up. Click on a new color and the arrow will change colors. 
To Change Text Colors 

• Click on the text so that handlebars appear. 
• On the bottom tool bar click on the Text Color icon which is the letter A with a 

band of color next to it. 
• A color palette will open. Click on another color and the text color will change. 

To Import a Graphic 
This feature only works in picture mode. It is not available in writing mode. 

• Click on the File menu and then click on Import a Graphic. 
• An Open window will pop up.  Click on the down arrow in the box next to Look In 

to navigate to where the graphic is located. 
• Double click on the graphic and it will be inserted into the document. 
• Handlebars on the image will allow users to re-size the graphic. Click on one of 

the red boxes and push it in or out. 
Exporting the Kidspiration 

• Kidspiration pictures can be exported as picture files. Click on the File menu and 
then on Export. 

• Choose which format the picture should be and then click on Save. Click on the 
down arrow next to Save in to choose where to save the picture and then click 
Save. 

Sound 
• Click on the Sound menu to make a recording that does with the activity. 
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• Teachers will need a microphone and sound card to use this feature. 
Using the Teacher Menu 

• Click on Teacher and Enable Teacher Menu to bring up additional features. 
• The Save as Activity allows teachers to save a picture that they created as an 

activity.  
• The Add a New Library allows teachers to create a collection of graphics to use 

in the program. 
• The Application Options allows teachers to make decisions about how the 

program functions. 
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 Favorite Character Graph 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional tool 
in my classroom? Can I create graphs using Graph Club? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: 
Which is our favorite book character this week? 
 
Learning Goals: 

• Students will listen and participate in the activity. 
• Students will vote for their favorite book character 

for this week. 
• Students will count accurately and record 

information on the graph. 
 
Prior Knowledge 
Students need to have had some knowledge of graphing. 
 
Materials: 
Data Collection Sheet, 
Copies of each book read so far that week 
Stuffed animals or pictures of story characters 
 
Technology Connections: 
Students will view build a graph whole group and then 
collect data to create a graph independently using Graph 
Club. 
 
Preparation: 
Have a large sheet of craft paper so that students can 
make a floor graph.  
Have either puppets or pictures of Max and a Wild Thing 
in a bag. 
Draw a picture of the data collection sheet leaving off the 
character's names. 
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Whole group 
instruction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Graph Club 

 
Procedures: 

1. Organize the students so that they can see the 
computer. Have the puppets or pictures of the story 
characters in a bag. Begin the activity by asking 
them what the word “favorite” means? 

2. If they are not sure, talk about it until they come to 
an understanding that a favorite is something a 
person really likes.  

3. Then tell students that today we are going to be 
recording some favorites using a graph. Ask them if 
they know what a graph is.  If they do not, tell them 
that a graph is a way to show numbers that make it 
easy to read and compare numbers. 

4. Open the bag and bring out the first story 
character (Max). The students should easily identify 
this character and be able to tell you some things 
about it. Have them describe what makes this 
character interesting and unique. Repeat this 
activity with the other 1-2 additional characters.  
(Wild Things) Set the characters on the bottom of 
the floor graph. 

5. Tell the students that you want to know which of 
those characters is their favorite. Have students 
get up and sit behind their favorite character facing 
you. When everyone has voted, write the number of 
students that chose the character below the name/ 
picture of the characters. Open Graph Club and click 
on Create a Graph. Take the data that was collected 
and create a graph showing students how to turn the 
pictures into words, how to add numbers into the 
columns, how to add a title, and labels to the graph. 

6. Read the graph and check it against the data 
collection sheet. Ask the students if they can tell 
which character was their favorite this week and 
which character was not liked as much this week? 

7. The next day tell students that they are going to 
work together to gather data about favorites and 
then create a graph. 

8. Put the students into pairs. Give each child a data 
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Paired 
computer usage 
 
 

collection sheet and tell them that first they need 
to agree which two items they want to find out 
about. Give examples in the form of a question: 
Do you like Arthur or Little Bear better? 

9. Put the students into pairs. For five minutes, have 
the partner groups determine which book 
characters they want to ask about. Tell them that 
when they come back to meeting they need to have 
their names on their paper and the name or picture 
of a character in each box. Circulate among the kids 
helping them complete this task. Using the initials of 
the characters or having the students draw pictures 
of the characters instead of the name are a couple 
of ways to solve the writing issue. 

10. Have pairs of students come up to pose their 
question and using the floor graph have the rest of 
the class move and sit in the correct column to vote 
their choices.  

11. In a one-computer classroom, the next step would 
be to have a pair of students come up and create 
their graph using Graph Club while the other 
students are watching. Describe what the students 
are doing as they complete the graph for the rest of 
the class. 

12. Staple the papers for each pair together and put in 
a folder near the computer so that when pair is done 
they can pull the next pair’s papers and get them to 
do the activity. If a lab setting is available, then 
pairs of students can work on this all at once. 

13. When students have completed their graph, have 
them print 2 copies, write their name on them, and 
turn those copies and their data sheets in together. 

14. Review their graph for accuracy based on their data 
collection sheet. Teachers also may want to take the 
time to have students talk about the graph. 
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Favorite Character Data Collection Sheet 
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Software Helper 
Graph Club  

 

The Graph Club is a versatile school graphing tool. The Graph Club begins with a short 
introduction featuring Fizz and Martina.  Following the introduction (which you have the 
option of skipping) you come to The Graph Club’s main menu. This menu lets you select 
one of The Graph Club’s four modes, each of which emphasizes a different set of 
graphing skills. Simply click one of the boxes and you will find yourself ready to start 
graphing. 

 
Explore Mode 
Explore mode allows you to create graphs. When you enter Explore mode, a pair of blank 
graphs automatically appears on your screen -- one picture graph and one bar graph. 
When you add or delete data in one of the graphs, the other graph changes 
automatically, allowing you to view the same data side by side in different formats. 
 
Enter and Delete Data 
Click an icon (from the row of icons at the top of the graph), hold the mouse button 
down, and drag the icon into the graph. Watch for the bar to appear over the icon at 
the bottom.  When the column is highlighted, release the mouse. One unit will be added 
to your graph. You can delete an entry by clicking on it when the X appears. 
 
Change Axis Labels, Icon Labels, or Table Title:  To change axis labels, go to your bar 
graph and click "What" (above the Graph Type buttons). Enter a label for the X axis. Do 
the same for the Y axis by clicking "How Many." 

 
To add or change icon labels, click the little icons along the X-axis and enter a label for 
each one. (Each item in your graph can be labeled with either an icon or text.) 
 
Graph Menu: 

Graph Kinds: This option lets you choose how many kinds of objects you will be 
graphing.   
 
Choose Scale Maximum: This does the same thing as clicking on the words each=1 
in the upper left-hand corner of the graph.  You can choose what value each 
picture has in your graph. 
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Choose Symbols: Click and drag on the symbol that you wish to use to replace 
those currently on the graph. Design Your Own Icons.  You can import your own 
graphics to use as icons. Copy the graphic you want into the Clipboard.  Open The 
Graph Club.  Choose 'Choose Symbols' from the Graph menu.  Click Paste from 
Clipboard. The cursor will change to your icon. Now just click the icon bin where 
you wish to place your icon! 
 

Options Menu: 
Graph Vertically, Graph Horizontally: This allows you to change the orientation 
of your graphs on the screen. 
 
Show bar and line grid: This enables you to show or hide the grid. 
 
Show axis labels: This enables you to show or hide the axis labels. 

 
Special Menu 
Edit Groups: Add and edit classes for use with the Random Student Picker™. The 
Random Student Picker lets you randomly select a student to enter data, answer a 
question, interpret a graph, or offer his or her opinion. It is a fun way to involve the 
entire class and keep students on their toes! 

 
Here is how to enter and edit data for a class or group: 
 
1.  Choose Edit Groups from the Special menu. Then click New Group and enter a 
name for your class. 
 
2.  Click New Student and enter the name of a student in the class. You can enter 
as many names as you want. 
 
3.  To edit a class list, select the name of the group in the Groups box on the left. 
You will then see a class list in the box on the right. You can now add or remove 
students from the list. To remove a student, just select the appropriate name and 
click Remove Student. 
4.  To remove a group, select the name of the group in the Groups box and click 
Remove Group. 
 
5.  To determine which group the Random Student Picker will use, select that 
group from the Groups box, click Close Group Editor, and Keep Any Changes. Now 
you are ready to pick a student! 
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Pick Student: Activates the Random Student Picker. If you have more than one group 
set up, you’ll need to choose Edit Groups and select the group you want the program to 
pick from before you choose Pick Student. To leave the Random Student Picker, just 
click the graphic. 

 
Print Special Setup: Select custom options for printing the special graphics that come 
with The Graph Club (including Match Certificates).  Blank Match Certificates, for 
example, should be printed landscape rather than portrait.  

 
Print Special: Choosing Print Special from the Special menu lets you print special 
graphics.  The lesson pictures are from a special Graph Club Curriculum Kit that can be 
ordered separately. 

 
Teacher Options:  Choosing Teacher Options from the Special menu lets you customize 
preferences to meet the needs of your students. This option is always grayed (to 
restrict access). To select Teacher Options hold down the Shift and Control keys and, 
without letting go, pull down the Special menu and choose Teacher Options. (Note: If 
you pull down the Special menu before pressing Shift and Control, Teacher Options will 
remain grayed.) 

 
The Teacher Options menu allows you to set the following preferences: 
 

General Options 
Checking the first option lets you allow multiple graph sets to be opened.  
 
Checking the second option lets you disable line graph buttons when more than 
one symbol is chosen. (Line graphs chart changes of one thing over time. A line 
graph with multiple symbols could be confusing.) 
 

Allow Students to Use 
This option lets you restrict the types of graphs (table, picture, bar, line, circle) 
students can use.  
 

Match Activity Settings 
These settings allow you to control a number of Match mode features. You can: 
• Select the graph type for the randomly generated graph (the "from" 

graph). This one appears on the left of your screen. 
• Select the graph type students will create (the "to" graph).  
• Determine how many kinds of things will be graphed (from 1 to  
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• Restrict students from changing the type of graph they match "from" and 
"to" (by graying the Graph Type buttons in Match mode graphs). 

 
Sound Preferences 
These options allow you to turn various program sounds on and off. 
 
Match mode generates a random graph and challenges students to create a different 
type of graph that represents the same data. Match mode gives students hands-on 
experience reading graphs and lets them see the transformation of data from one form 
to another.  

 
After opening a new file in Match mode:   

• Complete the Match challenge; then click Check My Match!  
 

• If the program finds an incorrect match, it tells you, "Now match the 
others!"  The Graph Club gives students as many tries as they need to match 
the graph  correctly. 

 
• If all matches are correct, a graphic will appear saying, "Great Job! You 
 Matched It!"  Click this graphic to make it disappear. 

 
• After successfully completing a match, click Print Certificate. This is a 
great  way to reward students’ success with graphing. Click Next Match to try 
 another matching challenge! 

 
Cool Feature: Using Teacher Options... in the Special menu, you can change the 
Match mode graph types and control a number of other Match mode features. 

 
Create Mode 
This mode addresses the cognitive challenge of transforming data from numeric to 
graphic form. Create mode automatically brings up a table with each data value set to 
zero. Students can then collect a set of data, enter it into the table in numeric form, 
and explore how those numbers are transformed as views of other graph types (picture, 
bar, line, or circle) are created.  
 

After opening a new file in Create mode: 
• Click each zero and enter data for your table. The default scale maximum is 
 10, a setting you can change by choosing Choose Scale Maximum... from the 
 Graph menu. 
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• Once you have entered data for each item, go to the Graph menu and 
choose Make Another Graph. This allows you to see your data represented in 
 different forms. (As you open additional graphs, you may need to resize 
them  to see them all at once.) 

 
Guess Mode 
Guess mode is designed to build critical-thinking and graph-reading skills, and help 
students understand that there are often many good answers to a question. This 
brainstorming activity also develops an awareness of the many different types of data 
that can be represented in graph form. 
 
Guess mode randomly generates graphs and challenges students to hypothesize about 
what the data might represent, why someone would have made that particular graph, and 
what people could conclude from the graph. (While the data is generated randomly, you 
can change the icons to graph any type of information you choose.)   
 
Cool Activity: Using New in the File menu, open several Guess graphs at once (each will 
have the same symbols, but different data). As each graph is generated, ask students to 
compare the data. Challenge them to explain what underlying differences the graphs 
could be representing. 
 
Cool Feature: Change the icons in the graph for a variety of critical thinking challenges. 

Suggested Activities 

Favorite ice cream flavors:  chocolate, vanilla, strawberry, mint 

Pets:  dog, cat, rabbit, fish, bird 

Favorite fruit:  apple, orange, strawberry, cherry, lemon, lime, banana, pear, pineapple 

Favorite Holiday:  Fourth of July, Thanksgiving, Christmas, Hannakah,  Halloween, 
Easter 

Favorite Season:  Spring (flower), Summer (sun), Fall (leaf), Winter (snowflake) 

Weather:  Sunny, Partly Cloudy, Rainy, Thunderstorm, Snow 

Favorite Sport:  Soccer, Basketball, Football, Skating, Baseball 
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Whole Group Learning with your PC 
 

Blowing UP Your Content! 
The Data Projector 

This piece of hardware is quickly becoming the choice of educators for whole group 
instruction in their classroom. The data projector is the equivalent of the movie 
projector except instead of film being projected on the wall it projects what’s on your 
computer.  These use to be so expensive that districts were lucky to have just one. 
Recently manufactures have broken the $1000 floor on some models. Now it is not 
uncommon to see new schools being built with these built-in to all classrooms. Even 
though these can be purchased for under $1000 plan to spend about $1200-$1600 for 
one of these for your classroom.   
 
Web Resources:  
http://www.zardec.net.au/keith/project.htm  

 
That’s a Really BIG Mouse! 

The Interactive White Board 

Interactive White Boards often called Smart Boards (Brand Name) are showing up 
in great numbers in classrooms around the country.  These devices basically put the 
operation and usually very powerful visualization software at the hands of teachers 
in the front of their classrooms.  In general most of the brands,  (SmartBoard,  
ActivBoard,  Polyvision) are all the same but are separated by their operational 
software.  Use the links below to explore more about IWB’s.  

 
Web Resources: 
http://schoolcomputing.wikia.com/wiki/Interactive_White_Boards  

http://www.albany.k12.or.us/departments/instruction/smartboardresourcepage.php  

http://www.edfacilities.org/rl/interactive_whiteboards.cfm 

 

The Future? 
www.surface.com 

http://www.zardec.net.au/keith/project.htm�
http://schoolcomputing.wikia.com/wiki/Interactive_White_Boards�
http://www.albany.k12.or.us/departments/instruction/smartboardresourcepage.php�
http://www.edfacilities.org/rl/interactive_whiteboards.cfm�
http://www.surface.com/�
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Daily Diary 
 

 
 
 
 
Name: 
Date: 

 
 
Everyday you will be instructed to complete a “Daily Diary” entry. You will 
find the diary topic on the electronic bulletin board every morning. After 
you have written in and saved your diary, you will need to print 2 copies, one 
for your folder and one for your book. 
 
 
Today’s “Daily Diary” is  
 

 What did we do today that you would you like to try in your 
classroom? Did today give you any new ideas about technology and 
teaching with it? 

 
**** 
If your instructor has decided to utilize the class blog for your session 

please access it at the following web address 
http: //gisdk2. wordpress. com/ 

http://gisdk2.wordpress.com/�
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Setting Up a Virtual Book Mark Account 
 

1. Go to http://www.ikeepbookmarks.com by typing it in the location box of your 
Internet browser.  Press the Enter or Return key. 

2. Click on Click Here to Register.  

 
3. Type an account name. Your account name needs to be something that you can 

remember easily, such as the username that you use for your e-mail account. 
4. Enter an authoring password for your account.  You may want to use the same 

password that you use for your e-mail account so you can remember it. You will be 
asked to type the password a second time to confirm it. 

 
My Account Name: 
My Authoring Password: 
 

5. Click in the box next to Remember my Login to deselect that option on this 
computer if it is not a computer that you use exclusively. 

6. Choose Account Type from the drop down list. 
7. Click on Finished when you have completed the Contact Details at the bottom of 

the registration screen. The following screen will appear.  
8. Write the link to your account in your plan book or someplace so that you can get 

back to it easily. 
9. Click on option 2 to go to the home page for your account and to start adding links 

right away or option 1 to upload your links from your computer to your 
Ikeepbookmarks account. If you choose not to upload your bookmarks now, you 
can do so later. 

 
 
To Add Links to Your Account 
 
1. From the main page of your account click on Add. 
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2. The following screen will appear. Type the title of the link. Copy and paste the 
URL for the link into that field making sure that there are not two http://s in 
the field.  
A description of the link is optional but useful when the numbers of links grows.  

 
 

3. When the information for the link is complete, click Finished at the bottom of 
the entry screen. 

 
Notice that the links automatically appear in alphabetical order. From the main page, you 
can choose a different arrangement for your links by changing the drop down box next 
to the Add button for the links. 
 
To Organize Bookmarks 
 

1. From the home page click Add right underneath the words “These buttons, 
below, allow you to add or edit folders.”  The following screen will appear. 

 
2. Type the name of the folder and when you are done click Finished. You can create 

separate folders for classes, subjects or topics or any grouping that you can think 
of. 

3. To add links into a specific folder, open the folder first before clicking the Add 
button. 

4. Or, if you already have links that need to be organized, click the Edit button next 
to the list of existing links. 
 
Click in the empty box next to the title of the link. A green checkmark will 
appear. 

http://s/�
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On the left-hand side in the gray box, change the Destination Folder to the one 
the link should move to then click on the Move button. 
When you are back at your home screen, a new number should appear next to the 
folder you moved links into. 

 
To Upload Bookmarks from a Computer 
 

1. On the top of the page, next to red Ikeepbookmarks.com logo, click on Bookmarks 
from the list of menu options. 

2. Two choices appear on the screen.  Click on Upload Bookmarks to the Web and the 
following screen will appear. 

3. Choose the first option to upload all the existing favorites from the web browser 
you are using to the bookmark folder. Simply click on the arrow and wait. A box 
will appear letting you know if it was successful. 

4. Other options on the upload page allow users to upload only  
new material or to replace existing bookmarks in the ikeep bookmarks account 
with the ones from the browser on the computer that you are using.  Choosing to 
use the replace option will wipe out your existing bookmarks in you account 
and put new ones from your browser in there.  
 

Optional Features 
 
The Options menu allows you to give people access to your bookmarks. Choose 
Options from the menu next to the red l Ikeepbookmarks.com logo at the top of 
the web page. Select a password for the visitor and set up the visitor’s access 
options. The Options menu will allow you to share your bookmarks without other 
people.  
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File Management Help 
Keeping track of files can be challenging when you have many children on one computer 
or your students work both in a lab and in their room on computer. The following are 
some ways to manage this task. 
 
Set Up Folders on the Desktop for Different Subjects or Groups 

1. Close all programs and get to your desktop. 
2. Place your mouse cursor in the middle of the computer desktop. 
3. Right click and scroll to New and click on Folder. 
4. A folder will be placed on the desktop with the label highlight in clue and flashing. 

Type a name for a folder. 
 
Save Material into Folders Where Students Should Save their Work 

1. Create a document that you want the students to use and save it as a template 
into the folder where students will find it. Saving it as a template will prevent 
students from saving their work over the assignment. 

2. Teach students that when they open a document the immediately do a File Save 
As and put their number and name on it. Example 1Lynne 

3. When you open the folder all the students files should be in number order 
allowing you to quickly see who has not completed the assignment yet. 

4. If students can not yet type their name, open the template and save a copy of it 
with the student’s name into the folder. Then all the student has to do is open the 
document, do the assignment, save it and close it. 

5.  
Show Non-readers the Save Button 

1. When students are working there is nothing more discouraging than loosing their 
work. 

2. Show students the save icon on the toolbar and encourage them to use it often. 
 
 
 
 
 
 
 
 
 
 
 

Save Button 
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Show Non-readers the Exit Button 
1. Teach students early on that when the complete their assignment after they save 

they close it. 
2. Instead of having the students go to the File menu and drag down to Exit to close 

an assignment or program show then the X button. 
 
 
3. Students should get in the habit of leaving the computer the 

way they found it. 
 
When Assignments End Up Outside of Folders 

1. Click on the file, hold the left mouse button down and drag the file into the 
folder. 

 
When Assignments Get Lost 

1. Click on the Start menu and scroll up to Find. In Microsoft XP click on Start and 
then Search. 

2. Use either the name of the child as a search term or the date the student did 
the assignment. 

 
Use Experts 

1. If you are fortunate enough to have students who have computers at home or who 
are just comfortable on computers teach 2-3 to help with basic functions like 
saving and closing files. 

2. They in turn will train the next pair of students who will have this job.  
3. Make computer assistant part of the class job assignments. 
4. The next step in this process is to get the rest of the class used to asking these 

students for help. 
 
 
 
 
 

X Button 
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Water Habitats 
 

Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers:  How do I use Inspiration to 
create graphic organizers?  How do I use a CD-Rom with a whole 
group?  How do I use Kid Works or Student Writing Center?  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question:  
What animals live in water habitats?  Where are these habitats 
located?  
 
Learning Standards (State of Michigan): 
Assessed:  
Science Standard V.2:  Elementary 
Trace the path that rain water follows after it falls. ( Key 
concepts: Precipitation-rain, clouds, fog, run-off. Flow-downhill, 
to ocean, underground. Bodies of water-streams, rivers, lakes, 
oceans. Real-world contexts: Examples of water flowing locally, 
including gutters, drains, streams, wetlands.) 
 
Science Standard III.5:  Elementary 
Describe the basic requirements for all living things to maintain 
their existence. ( Key concepts: Needs of life-food, habitat, 
water, shelter, air, light, minerals. Real-world contexts: Selected 
ecosystems, such as an aquarium, rotting log, terrarium, 
backyard, local pond or wetland, wood lot.) 
 
English/Language Arts Standard 7: Early Elementary 
Begin to develop and use strategies for planning, drafting, 
revising, and editing a variety of text forms. Examples include 
identifying characteristics of their audience, mapping, and 
proofreading. 
 
Non assessed: 
English/Language Arts Standard 11: Early Elementary 
Generate questions about important issues that affect them or 
topics about which they are curious, and use discussion to narrow 
questions for further exploration. 
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Teaching 
Strategies 
Modeled 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole 
Group 
Instruction 
 
 
 
Partner 
Activity 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole 
Group Demo 
 
Center 
Activity 
 

 
Technology 
Strategies 
Modeled 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.m
bgnet.net/  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
KidWorks 
Deluxe 
 
 
 
 
 

 
Materials:  
Eyewitness Encyclopedia of Nature CD, sentence strips (K-2), 
reproducible student materials, Inspiration, Kid Works (K-2), 
Student Writing Center (3-5), scan converter, large classroom 
map 
 
Technology Connections:  
Students will view information from a CD and observe the 
teacher creating a web in Inspiration.  The teacher will model 
how to type sentences in Kid Works (K-2) or use Student Writing 
Center (3-5) to write a class paragraph.  Students in grades 3-5 
will write their own paragraph in Student Writing Center. 
 
Procedures:   
1. Ask students to name animals that live in the water habitats 

that they have been studying. We are going to be focusing on 
Oceans & Lakes. Write the animal names on the board as the 
students call them out.  

2. Explain to students that, in pairs, they will be using the web 
site http://www.mbgnet.net/  to identify the animals located 
on the activity sheet that follows. 

3. Instruct students on the use of the site. Click on Habitats 
and show students the Sea & Coast, Coral Reef and Lake & 
Wetland habitats.  Explain that the animals in the Sea & 
Coast habitat and in the Coral Reef habitat are all ocean 
animals.  Click on various animals in each habitat and discuss 
the information presented. 

4. Students use the animal activity page and identify each animal 
as Lake or Ocean animals. Print an L or O in the right hand 
corner of the animal picture identifying it as a Lake or Ocean 
habitat animal. 

5. Cut-out the animals out and paste them on the web activity 
sheet. 

6. Have your students choose one animal to write a sentence 
about. Print sentence on a sentence strip.  

7. Model the use of the software KidWorks Deluxe writing the 
sentence from the sentence strip. 

8. Students rotate through the computer station entering in 
their sentence and printing it out. 

http://www.mbgnet.net/�
http://www.mbgnet.net/�
http://www.mbgnet.net/�
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9. When each student has completed their portion of the class 
book, allow students to view the completed class book and 
share their sentences with the class. 

 
Assessment:  
Students will be assessed on the accuracy of their webs and 
participation in creating a class booklet. 
 
Extension:  
Have students create their own booklet in Kid Works, adding 
pictures to go with each page.   
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Water Habitats Fact Gathering Sheet 
Write down facts about three animals from each habitat. 

 
 

Sea & Coast- 
 
 
 
 
 
 
 
 
Coral Reef- 
 
 
 
 
 
 
 
 
Lakes & Wetlands- 
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Habitats Web 
Cut out the animals from the second page and glue them next to the correct habitat. 
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Animal Cut-outs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Frog 

Snail 

Sea Snake 

Newt Stickleback 
Puffin 

Duck 

Moorish Idol 

Dolphin 

Pilot Whale 
Lobster 

Beaver 
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Software List 
 
Graph Club 
Tom Snyder/Scholastic 
http://www.teachtsp.com/products/productdetail.asp?PS=GRPGRT 
Tom Snyder/Scholastic 
 
Letter Machine 
Riverdeep/Edmark 
http://www.computeractive.co.uk/vnunet/downloads/2128524/letter-machine  
Free 
 
Kid Pix 
Broderbund 
http://www.kidpix.com/ 
$10.00-20.00 single user 
 
Kidspiration 
Inspiration             
http://www.inspiration.com/ 
 
Wordpress 
Blogging Software 
http://wordpress.com/  
 
 
 
 

http://www.teachtsp.com/products/productdetail.asp?PS=GRPGRT�
http://www.computeractive.co.uk/vnunet/downloads/2128524/letter-machine�
http://www.kidpix.com/�
http://www.inspiration.com/�
http://wordpress.com/�
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Notes 


	Software Helper
	Explore Mode
	Enter and Delete Data
	Edit Groups: Add and edit classes for use with the Random Student Picker™. The Random Student Picker lets you randomly select a student to enter data, answer a question, interpret a graph, or offer his or her opinion. It is a fun way to involve the en...
	Pick Student: Activates the Random Student Picker. If you have more than one group set up, you’ll need to choose Edit Groups and select the group you want the program to pick from before you choose Pick Student. To leave the Random Student Picker, jus...
	Print Special Setup: Select custom options for printing the special graphics that come with The Graph Club (including Match Certificates).  Blank Match Certificates, for example, should be printed landscape rather than portrait.
	Print Special: Choosing Print Special from the Special menu lets you print special graphics.  The lesson pictures are from a special Graph Club Curriculum Kit that can be ordered separately.
	Teacher Options:  Choosing Teacher Options from the Special menu lets you customize preferences to meet the needs of your students. This option is always grayed (to restrict access). To select Teacher Options hold down the Shift and Control keys and, ...
	General Options
	Allow Students to Use
	Match Activity Settings
	Sound Preferences
	Create Mode
	Guess Mode
	Whole Group Learning with your PC
	Interactive White Boards often called Smart Boards (Brand Name) are showing up in great numbers in classrooms around the country. These devices basically put the operation and usually very powerful visualization software at the hands of teachers in th...
	http://www.albany.k12.or.us/departments/instruction/smartboardresourcepage.php
	http://www.edfacilities.org/rl/interactive_whiteboards.cfm
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